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Introduction
Welcome to Field Service Suite, a component of Business Portal for Microsoft 
Dynamics® GP. Using Field Service Suite, you can:

• Create, modify, and view service calls
• Enter and track meter readings
• Create, modify, and view return merchandise authorizations (RMAs)

Any service calls or RMAs entered via the Field Service Suite are automatically 
updated to Microsoft Dynamics GP for processing. Additionally, service call and 
RMA entry is more efficient and accurate, as address and contact information is 
automatically supplied based on company data and mappings.

This guide contains information for system administrators to:

• Set up users for Field Service Suite
• Provide access to Field Service Suite
• Manage site settings for Field Service Suite

This guide also contains information for users to:

• Enter, view and modify service calls
• Enter, view and modify RMAs
• Enter, view and modify meter readings

Field Service Suite is an extension of the service call and RMA functionality found 
in Microsoft Dynamics GP. This guide occasionally references settings and 
functionality within Microsoft Dynamics GP. Therefore, you should be familiar 
with the Microsoft Dynamics GP Field Service Series before attempting to use Field 
Service Suite. Refer to the appropriate Microsoft Dynamics GP user guides for 
assistance with any functionality not explicitly described in this document.

Check for updated instructions
This information was current as of March 10, 2010. The documentation may be 
updated as new information becomes available. Check the Microsoft Dynamics GP 
documentation web site (http://go.microsoft.com/fwlink/?LinkId=185513) for the 
most current documentation.

This introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Additional resources
• Send us your documentation comments

http://go.microsoft.com/fwlink/?LinkId=185513
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What’s in this manual

This manual includes the following chapters:

• Chapter 1, “Installation and setup,” explains how to install and set up Field 
Service Suite.

• Chapter 2, “Service calls,” explains how to navigate the Field Service Suite 
application and perform daily activities relating to service call and meter 
reading functionality.

• Chapter 3, “RMAs,” explains how to navigate the Field Service Suite 
application and perform daily activities relating to RMA functionality.

Symbols and conventions

This manual uses the following symbols to make specific types of information stand 
out.

This manual uses the following conventions to refer to sections, navigation, and 
other information.

Additional resources

In addition to this manual, the following documentation is included with this 
release of Business Portal.

Manuals
The following PDF manuals are included in the Documentation folder on the 
Business Portal media.

Business Portal Installation Guide The Installation Guide 
(BusinessPortalInstallation.pdf) provides step-by-step instructions for installing 
Business Portal.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts, and suggestions.

The warning symbol indicates situations you should be especially aware 
of when completing tasks. Typically, this includes cautions about 
performing steps in their proper order, or important reminders about 
how other information in Business Portal or the back office may be 
affected.

Convention Description

Saving favorite 
queries

Italicized type indicates the name of a section or procedure.

File > Print The (>) symbol indicates a sequence of actions, such as choosing items 
from a menu or toolbar or clicking buttons in a window. This example 
directs you to go to the File menu and click Print.

Bold Bold type indicates navigation, tab names, menus, commands, buttons, 
field names, keywords, and functions.

TAB or ENTER Small capital letters indicate a key or a key sequence.
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Business Portal Administrator’s Guide The Administrator’s Guide 
(BusinessPortalAdminGuide.pdf) explains how to set up and configure Business 
Portal.

Application manuals User and Administrator manuals for each application 
installed in Business Portal are available in the Documentation folder.

Help
Help is available by clicking the Help icon button, located in the upper-right corner 
of any page. The help that is displayed depends on whether you open help from a 
Business Portal page, a Microsoft® Windows SharePoint® Services page, or a 
Microsoft Office SharePoint Server 2007 page or Microsoft SharePoint Server 2010 
page.

Business Portal help When you click the Help icon button on a Business Portal 
page, the relevant help topic for that page is displayed. You can use the search field 
on the help page to search for information. You also can click the Home icon button 
to browse the contents of the help.

SharePoint help  Many of the features included in Business Portal—such as 
document libraries, lists, announcements, links, and alerts—are provided by 
Windows SharePoint Services. General information about these features is provided 
in the Administering Business Portal help. For more detailed information, refer to 
the Windows SharePoint Services help, which can be accessed by clicking the Help 
icon button in the upper-right corner of any Windows SharePoint Services page. If 
you’re using Office SharePoint Server 2007 or Microsoft SharePoint Server 2010, 
additional help related to the SharePoint Server features also will be available.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Installation and setup
The following information explains how to install the software and perform setup 
tasks prior to using it in your organization.

The following sections are included:

• Installation preparation
• Microsoft Office SharePoint Server setup
• SQL Server setup
• Field Service Suite installation
• Windows SharePoint Services setup
• Domain user setup
• Entity ID assignment
• Roles and permissions

Installation preparation

Business Portal must be installed and configured for your environment prior to the 
installation of the Field Service Suite. Additionally, the Field Service Suite is 
available only if you are installing on Microsoft Office SharePoint Server, Enterprise 
Edition.

Intranet vs. Extranet deployment
Business Portal can be deployed in an intranet or extranet environment. The 
environment chosen determines who is able to use the Field Service Suite.

Intranet An intranet is a company’s internal network. When you deploy Business 
Portal in an intranet environment, only internal users are able to manage service 
calls and/or RMAs in the Field Service Suite.

Extranet An extranet is an extension of a company’s intranet that provides 
limited access to authorized outside users. When you deploy Business Portal in an 
extranet environment, both your external users (customers) and internal users are 
able to manage service calls and/or RMAs in the Field Service Suite.

If you decide to deploy Business Portal in your intranet, you can add external access 
at a later time.

For information about setting up intranet and extranet environments, see the 
Business Portal Installation Guide. 

Before starting the Field Service Suite, refer to the Business Portal Administrator’s Guide 
for important information about user security setup. These mappings are vital to the success 
of the Field Service Suite.

Microsoft Dynamics GP modules required
Before installing the Field Service Suite, verify that the following Microsoft 
Dynamics GP Field Service modules are registered and set up:

• Service Call Management
• Returns Management

For more information about these modules, refer to the Microsoft Dynamics GP 
Field Service documentation.
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Access rights required
To install the Field Service Suite, you must log on to the Business Portal Web server 
as a user with the correct access rights. Specifically, you must be a member of the 
Administrators group in SharePoint, Microsoft SQL Server®, and Web Services.

Microsoft Office SharePoint Server setup

If you’re going to install the advanced version of Office SharePoint Server, you must 
first create domain user accounts that SharePoint can use to launch services, run 
processes, and connect to the SQL Server.

You don’t need to create these accounts if you’re going to use the basic installation 
method for Office SharePoint Server. The following user accounts for Office 
SharePoint Server should be created:

• A domain user account that acts as the application pool identity for the Web 
application where you will create the Business Portal site collection. We 
recommend creating an account called oss_user. This user account must be a 
member of the IIS Worker Process (IIS_WPG) group on the web server, and the 
account must be dedicated (used only by SharePoint). If you’re installing on 
multiple web servers, the account must be a Business Portal user.

• A domain user account under which the Office SharePoint Server Search service 
can run. The user account must be a member of the Administrators group on 
the computer that is running the Search service.

• A domain user account that is used to crawl content on your sites and create 
indexes.

• A domain user account that acts as the identity for the SharePoint Central 
Administration application pool. The Windows SharePoint Services Timer 
service also runs under this account.

• A domain user account that acts as the application pool identity for the web 
application where you will create the Shared Services Provider (SSP).

• A domain user account under which the SSP runs.

Additional information concerning the configuration of Office SharePoint Server 
can be found in the Business Portal Installation Guide.

SQL Server setup

During the Business Portal installation, you’ll need to enter the following SQL 
Server logon IDs:

• The SQL Server administrator logon ID—entered in the Connection 
Information window if you choose to use SQL authentication—can be any SQL 
logon ID that has administrator privileges with access to all Microsoft 
Dynamics GP SQL databases. You can use the sa logon, but are not required to 
do so. These credentials are used only during the Business Portal installation 
process, to permit the installation wizard to create the Business Portal logon ID. 
The SQL Server administrator credentials are not used again.
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• The Business Portal logon ID—entered in the Business Portal SQL 
Configuration window—is the logon account Business Portal uses to access 
data in SQL Server. This logon ID is used continually to access Microsoft 
Dynamics GP data. The default entry in the Business Portal SQL Configuration 
window is BusinessPortalUser. However, you can also use an existing SQL user 
or create your own SQL user. If you enter a nonexistent SQL logon in the 
window, that user will be created automatically in SQL Server during the 
Business Portal installation. If you’re installing Business Portal on multiple web 
servers, be sure that the same Business Portal logon ID and password are used 
for all web servers. 

Additional information concerning SQL configuration can be found in the Business 
Portal Installation Guide.

Field Service Suite installation

If you did not install Field Service Suite when running the Business Portal 
installation wizard, use the setup wizard to add it to your Business Portal 
installation. For additional information regarding setup, refer to the Business Portal 
Installation Guide. 

1. From the Business Portal installation media, double-click the CDSetup.exe file.

2. Under Install, click Business Portal for Microsoft Dynamics GP.

3. The End-User License Agreement window appears. Read and accept the terms 
in the License Agreement, and click Next.

4. The Connection Information window appears. Enter the location of your 
Microsoft Dynamics GP SQL Server database, and select the type of 
authentication that should be used when creating objects used by Business 
Portal. Further information on this step can be found in the Business Portal 
Installation guide.

5. The Select Features window appears. Select the Field Service Suite module to be 
installed.

6. The Ready to Install window appears. Click Install. The installation process 
may take several minutes to complete.

7. The Finish window appears. Click Finish.

8. We recommend creating a backup of the Web.config file after installing Business 
Portal applications. The Web.config file is located at 
C:\inetpub\wwwroot\wss\VirtualDirectories\<port number>, where <port 
number> is the port number of the IIS web site where you installed Business 
Portal.



C H A P T E R  1    I N S T A L L A T I O N  A N D  S E T U P

8 F I E L D S E R V I C E S U I T E

Windows SharePoint Services setup

SharePoint groups are used to grant access to Business Portal sites, document 
libraries, and pages. When you log on to the Business Portal, menu options and 
Quick Launch items appear based on the SharePoint groups you belong to. 

For additional information about managing groups, see the Windows SharePoint 
Services Administrator’s Guide.

1. From the Site Actions menu on any Business Portal page, choose Site Settings.

2. Under Users and Permissions, click People and Groups. Click Groups in the 
Quick Launch to display all groups.

3. Click the name of the group that you want to add users to. Choose New > Add 
Users. 

• To access RMA information, select the Business Portal Return Customer 
group. 

• To access service call information, select the Business Portal Service 
Customer group.

4. Follow the instructions on the page to enter user names and select permissions. 
Additionally, you may reference Add Users to SharePoint Groups the Business 
Portal Administrator’s Guide for in depth steps on assigning users to a 
SharePoint group.

5. Click OK to save your changes.

Domain user setup

A domain user must be set up in Business Portal prior to completing the mappings 
in the Field Service Suite. 

1. Open the Dynamics Security Console. (On a computer where the console is 
installed, choose Start > Administrative Tools > Dynamics Security Console.)

2. Select the Role Assignments node in the left pane of the Dynamics Security 
Console.

3. In the Action menu, click Add. The Add Role Assignments window appears.

4. In the Role list, select the role that you want to assign users or groups to:

• For RMA information, select the role of Returns Customer - Self. 

• For service call information, select the role of Service Customer - Self.

5. Click Add Windows Users to add individual windows users to the role 
assignment. Click Add Groups to add application level groups or enterprise 
level groups to the role assignment.

Roles are important because they dictate what pages and information you are able 
to view. These roles determine how much or how little access a user has, including 
the determination of read/write permission
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Entity ID assignment

Assigning the entity ID in the Dynamics Security Console associates the user with 
the appropriate back office customer. The Business Portal Administrator’s Guide 
contains additional information about this task.

1. Open the Dynamics Security Console. (On a computer where the console is 
installed, choose Start > Administrative Tools > Dynamics Security Console.)

2. Select the Entity ID Assignments node in the left pane of the Dynamics 
Security Console.

3. In the Action menu, click Add. The Add Entity ID Assignments window 
appears.

4. Click Select Windows User to select the user you would like to assign to a back 
office entity.

5. In the Entity Type list, select the entity type you would like to assign to the 
user. For Service Center, the entity type is customer.

6. In the Company list, select the company where the entity exists. A list of entity 
IDs for the selected entity type and company appears.

7. In the Entity list, select the ID you would like to assign to the user.

8. Click OK to save the new assignment.

Roles and permissions

In Business Portal, the following groups should be considered:

• Business Portal Return Customer Group
• Business Portal Service Customer Group

The Business Portal Return Customer Group allows you to access the RMA 
Documents in the control panel in the Business Administration portal. The Business 
Portal Service Customer Group allows you to access the service calls and meter 
readings entry in the Quick Launch. 

In the Dynamics Security Console, the following roles and permissions should be 
considered:

• Return Customer Role
• Service Customer Role

Additionally, the following settings should be considered when setting up the 
Entity ID:

• Type: Customer
• Company: Corresponding company name

These settings allow you to be set up in association with the appropriate company 
and, in turn, the correct company data. This is important because the address, 
contact name, and equipment information is all driven from the company that is 
selected and associated to your ID.
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Chapter 2: Service calls
This part of the documentation explains how to navigate the Field Service Suite 
application and perform daily activities relating to service call and meter reading 
functionality.

The following topics are discussed:

• Enter a new service call
• View existing service calls
• Enter meter readings

Service Center home page

In Business Portal, click the Service tab to display the Service Center home page. 
You can access all the Field Service Suite functionality from this page.
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Enter a new service call

To enter a new service call, click the New Service Call link on the Service Center 
Quick Launch.

Address and contact information is automatically provided, based on the company 
information that is loaded during the entity ID assignment, and these fields are 
required for submission. 

Once you have filled out the document, click Create to submit it. The View Service 
Call Details window appears with the assigned service call number and a call 
status. The call has now been created in Microsoft Dynamics GP, and can be recalled 
by using the assigned service call number. 

By clicking OK, you can view the newly created service call under Open Service 
Calls. This view can also be accessed by clicking the corresponding hyperlinks in 
the Service Center Quick Launch.
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View existing service calls

To view existing service calls, click the Service Call link or Service link in the 
Service Center Quick Launch. The Service Calls List page displays all invoiced, 
open, and historical service calls.

Click a link corresponding to an open service call number to view additional details, 
such as equipment and company information.

Enter meter readings

To enter meter readings, click the Enter Readings link on the Service Center Quick 
Launch. The Enter Meter Readings window allows you to enter any meter reading 
information obtained from metered equipment. 

Using the Address list, you can select from any available addresses that are stored 
in the system. Selecting an address automatically provides the Contact, Address, 
City, State, and ZIP information. Select the serial number for the metered part, and 
the Item Number field will display the corresponding item. Up to five meter 
readings may be entered for the equipment within one form. Click Post to post and 
update the readings in Microsoft Dynamics GP.
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Chapter 3: RMAs
This part of the documentation explains how to navigate the Field Service Suite 
application and perform daily activities relating to RMA functionality.

The following topics are discussed:

• Enter a new RMA
• View existing RMAs

Enter a new RMA

To enter a new RMA, click the New RMA link on the Service Center Quick Launch.

The address and contact information is provided based on the entity ID, and are 
required to create the RMA. Once you have filled out the document, click Create. 

The Preview RMA Document window appears, and the RMA is assigned a number 
and a status. Once you click OK, you can view the newly created RMA from the list 
of RMAs. The RMA has also been created in Microsoft Dynamics GP and you can 
recall it there by using the assigned RMA number.
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View existing RMAs

You can view existing RMAs by clicking the Returns or RMA Documents links on 
the Service Center Quick Launch.

On the Return Documents List page, click a link corresponding to an RMA number 
to view details such as additional equipment and company information.
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